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Foreword

This User's Guide describes how to access and use TShell, the graphical user interface (GUI) for the Traffic
Software Integrated System (TSIS) traffic modeling environment.  ITT Industries, Inc., Systems Division
developed and is maintaining TShell under the direction of the Federal Highway Administration (FHWA) on
Contract Number DTFH61-95-C-00125.

Please refer to the TSIS User's Guide for information on obtaining TSIS and TShell.
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Abstract

TShell is the graphical user interface for FHWA's Traffic Software Integrated System (TSIS).  This user-
friendly interface integrates the TSIS tools, provides a environment where you can easily configure and
execute those tools, and enables you to effectively manage your traffic analysis projects.

This guide:

• Introduces users to the capabilities and features of TShell.

• Explains in detail how to use the TShell interface and its components.

• Describes how to use the TShell Project View to manage traffic analysis projects.

• Describes how to configure and maintain tools in  the TSIS integrated environment.
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1 About TShell

1.1 Introduction
This guide provides a comprehensive description of how to use TShell, the user interface for the TSIS
environment.   It is designed to support traffic engineers using TSIS to conduct traffic operations analysis.
However, it describes neither the technical aspects of traffic simulations, nor the types of analyses that can be
performed using traffic simulations.

In preparing this manual, the authors assumed that you are familiar with the general operation of the Microsoft
Windows platforms on which TSIS runs.  For general help on using Windows, such as managing the operating
system environment and using the file system, please refer to the Microsoft Windows user documentation
provided with your computer or available on-line from Microsoft.

1.2 Overview
TSIS is, by design, an integrated set of traffic analysis tools.  To provide this integrated environment, TSIS is
implemented using a container/component architecture.  In this architecture, TShell serves as the container,
while the tools are its components.  Because of its centralized role in this architecture and because it provides
the primary user interface for TSIS, TShell is often referred to as TSIS.  In reality, TSIS is a collection that
includes all of its constituent tools and TShell.  Although TShell makes these tools easier to use, the important
work in TSIS is actually performed by the tools.

In this document, we concentrate on describing the user interface concepts of TShell.  While it is impossible to
discuss TShell without referring to the other tools in TSIS, we will focus on describing the features of TShell
that enable you to apply those tools effectively and to maintain the TSIS tool configuration.  Furthermore, this
document will illustrate how to use TShell to manage your traffic analysis projects.

For clarification, we introduce the following terminology.  A TSIS project is a set of simulation cases that
reflect a common theme, e.g., signal timing variations for an artery in downtown Washington, D.C.  A
simulation case is a single simulation for a specified traffic network as defined by its simulation input file, e.g.,
one of the signal timing variations.  A case includes the simulation input file and all data files generated by the
simulation during a run.  Note, multiple runs of the simulation for gathering statistics is still considered part of
a single case if the input (other than random number seeds) has not changed.

The following section describes the layout and the physical features of the TShell interface.  Subsequent
sections address the management of projects, the configuration and maintenance of tools, and the setting of
preferences for the environment.
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2 The TShell User Interface

2.1 The Interface Layout
TShell provides a point-and-click, window-based graphical user interface (GUI) that enables you to apply the
TSIS tools to conduct traffic operations analysis.  The following figure illustrates the TShell GUI and its
constituent elements.

Elements that compose the GUI include:

• Title Bar

• Menu Bar

• Toolbars

• Status Bar
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• Project View (displaying the project tree structure)

• Output View (displaying the TSIS Welcome browser tab)

• Workspace Window (displaying a traffic network in TRAFED)

The following sections describe these elements.  In those descriptions of the TShell GUI, we assume that you
are familiar with the general operation of Windows.  For general help on using Windows, such as managing
the environment, the file system and printing, please refer to the Microsoft Windows user's guides and on-line
help.

2.2 Title Bar
The TShell title bar operates as do the title bars of all Microsoft Windows multiple document interface (MDI)
applications.  Without any workspace windows open, the TShell title bar displays the TShell/TSIS icon and the
name of the application.  Buttons at the right of the title bar allow you to minimize, maximize or close TShell.

In general, each workspace window will display its own title bar that indicates the tool it represents and/or the
file the tool is operating on.  These title bars also contain the buttons to minimize, maximize or close the
window.  If a workspace window is maximized, its title bar is hidden and the contents of its title bar are
displayed in the TShell title bar.  When maximized, the window's minimize, maximize, and close buttons are
contained in the TShell menu bar at the right.

2.3 Menu Bar
The TShell menu bar operates as do the menu bars of all Microsoft Windows multiple document interface
(MDI) applications.  Without any workspace windows open, the default menu bar contains pull-down menus
that provide access for all TShell operations.

When launched, individual tools may add menus to the menu bar or modify the contents of existing menus.
Items in the menus will be enabled or disabled based on which sub-view (Project, Output, Workspace
Window) has focus (receives keyboard commands).  A sub-view gains focus when you click the mouse in that
sub-view.  For example, the Edit|Find menu item will operate on the Output View when it has focus and on the
TRAFED window when it has focus.  Each of these sub-views will process the Edit|Find command in its own
way.

The following sections describe each menu (and its included items) for the default TShell menu bar.  Please
refer the User's Guides for the individual tools for descriptions of the menus they add or how they process
menu commands.
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2.3.1 File Menu
The File menu allows you to open, close, and save files and projects , access print operations, and exit TShell.
It contains the following items:

New:  When you select the New item from the File menu, a submenu will appear.  The submenu contains a list
of items (tools) that you can use to create new files.  For example, with the Project File item, you can create a
new project (TCF) file.  The submenu contains items for all tools that belong to the Editor category.

Open…:  This command displays a file open dialog that allows you to select a file to open.  The Ctr+O key is
an accelerator key for this command.

Close:  This command closes the currently active document window.

Open Project…:  This command displays a file open dialog that allows you to select a project (TCF) file to
open.  The Ctr+T key is an accelerator key for this command.

Close Project:  This command closes the project associated with the currently highlighted item in the Project
View.

Save:  This command saves the active document to a file.  The Ctrl+S key is an accelerator key for this
command.

Save As…:  This command displays a file save dialog that allows you to select or specify a file name to
which to save the currently active document.

Print…:  This command displays a print dialog that allows you to print the contents of the active document
window or TShell sub-view that has focus.

Print Preview:  This command is used to display the contents of the active document on the screen, as it
would appear printed.  The functionality of this command depends on the tool associated with the active
document.

Print Setup…:  This command invokes the Print Setup dialog.  From this dialog, you can modify printer
settings such as the paper size and orientation.

Recent Files List:   This is a list of the last four files that you have opened or saved.  Selecting one of the file
names from the list, opens that file.

Exit:  This command closes all open windows and exits TShell.

2.3.2 Edit Menu
The Edit menu allows you to edit the currently active document or TShell sub-view.  It contains the items
described below.  The functionality of each of these menu items depends on the tool associated with the active
document.  Please refer to the Help for a specific tool for details regarding its edit commands.
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Undo:  This command undoes the last edit action for the currently active document or TShell sub-view.  The
Ctr+Z key is an accelerator key for this command.

Redo:  This command redoes the last edit action for the currently active document or TShell sub-view.  The
Ctr+Y key is an accelerator key for this command.

Cut:  This command removes the selected text or object from the active document and puts the selection into
the Windows clipboard.  The Ctrl+X key is an accelerator key for this command.

Copy:  This command copies the selected text or object from the active document or TShell sub-view and puts
the selection into the Windows clipboard.  The Ctrl+C key is an accelerator key for this command.

Paste:  This command inserts the contents from the Windows clipboard into the active document at the
location of the caret.  If there is a current selection in the document, this command replaces the selection with
the contents of  clipboard.  The Ctrl+V key is an accelerator key for this command.

Delete:  This command removes the selected text or object from the currently active document or TShell sub-
view.  If the selection is a file, case, or project from the Project View, the file(s) associated with that item are
deleted from the hard drive.  The Del key is an accelerator key for this command.

Select All:  This command selects all selectable items in the active document or TShell sub-view.  The
Ctrl+A key is an accelerator key for this command.

Find:  This command displays a find dialog that allows you to find specified text or objects in the active
document or TShell sub-view.  Ctrl+F key is an accelerator key for this command.

2.3.3 View Menu
The View menu allows you to hide or show the different sub-views and toolbars in the TShell interface.  A
checkmark beside an item indicates the particular sub-view or toolbar is currently visible.  Selecting an item on
the menu switches (toggles) the visibility state of the item (i.e., a visible item will become hidden and a hidden
item will become visible).  The View menu contains the following items:
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Full Screen Mode:  This command toggles the active document view between full screen and normal modes.
In full screen mode, the active document is displayed using the entire desktop viewing area (the entire screen).
The F2 key is an accelerator key for this command.

Main Toolbar:  This command toggles the visibility of the TShell Main toolbar.  This toolbar contains
buttons that duplicate many of the commands in the File, Edit, and Help menus.

Traffic Tool Toolbar:  This command toggles the visibility of the Traffic Tool toolbar.  This toolbar contains
buttons that activate each of the tools in the current configuration of the TSIS environment.

Simulation Control Bar:  This command toggles the visibility of the Simulation Control toolbar.  This
toolbar contains buttons that provide run control (abort , pause, resume, and step) for the TSIS simulation tools .

Project View:  This command toggles the visibility of the TShell Project View.

Output View:  This command toggles the visibility of the TShell Output View.

Welcome Page:  This command toggles the visibility of the Welcome tab within the TShell Output View.

Status Bar:  This command toggles the visibility of the TShell status bar.

2.3.4 Options Menu
The Options menu allows you to set user preferences for TShell and provides access to the Project Description
dialog.  It contains the following items:

Preferences…:  This command displays the TSIS Preferences dialog which allows you to set user
preferences for the TShell interface.

Project Description…:  This command displays the Project Description dialog that allows you to view or
edit the contents of the project file for the project associated with the currently selected item in the Project
View.

2.3.5 Tools Menu
The Tools menu provides you access to executing and configuring the tools contained in the TSIS
environment.  Within TSIS, tools are divided into four categories:  Editors,  Simulation, Processors, and
Viewers.  This menu is divided into submenus that reflect the TSIS tool categories.  This menu also provides a
submenu that lists all of the Visual Basic  scripts that you have defined.  These submenus are described in the
following sections.
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Execution Controls Submenu
The Execution Controls submenu contains commands that allow you to control the execution of a simulation
tool.  It contains the following commands:

Abort:  This command terminates the execution of the currently running simulation tool.

Pause:  This command pauses the execution of the currently running simulation tool.

Resume:  This command resumes the execution of the currently paused simulation tool.

Step:  This command executes one time step for the currently paused simulation tool.

Editors Submenu
The Editors submenu contains a list of all of the currently defined editor tools .  Selecting one of these items
activates the tool on the active document or on the selected item in the Project View.  Submenu items will be
disabled (grayed) if the tool is not valid for the document or selected Project View item.  This list of tools is
dynamic and will reflect any editor tools that you define, in addition to the pre-configured editor tools supplied
with TSIS.  The following figure illustrates the look of the tool category submenus on the Tools menu.

Simulation Submenu
The Simulation submenu contains a list of all of the currently defined simulation tools .  Selecting one of these
items activates the tool on the active document or on the selected item in the Project View.  Submenu items
will be disabled (grayed) if the tool is not valid for the document or selected Project View item.  This list of
tools is dynamic and will reflect any simulation tools that you define, in addition to the pre-configured
simulation tools supplied with TSIS.

Processors Submenu
The Processors submenu contains a list of all of the currently defined processor tools .  Selecting one of these
items activates the tool on the active document or on the selected item in the Project View.  Submenu items
will be disabled (grayed) if the tool is not valid for the document or selected Project View item.  This list of
tools is dynamic and will reflect any processor tools that you define, in addition to the pre-configured
processor tools supplied with TSIS.
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Viewers Submenu
The Viewers submenu contains a list of all of the currently defined viewer tools .  Selecting one of these items
activates the tool on the active document or on the selected item in the Project View.  Submenu items will be
disabled (grayed) if the tool is not valid for the document or selected Project View item.  This list of tools is
dynamic and will reflect any viewer tools that you define, in addition to the pre-configured viewer tools
supplied with TSIS.

Scripts Submenu
The Scripts submenu contains a list of all of the currently defined Visual Basic script files that reside in the
"Scripts" folder under the folder to which TSIS was installed.  Selecting one of these items activates the Script
Tool on the selected script file.  This list of script files is dynamic and will reflect any script files that you
define, in addition to the pre-configured scripts supplied with TSIS.

Tool Configuration… Command
This command displays the Tool Configuration dialog that allows you to define, edit, and delete tool
configurations.  This dialog is described in detail in the Tool Configuration chapter.

2.3.6 Window Menu
The Window menu allows you to control the layout of the documents within the TShell workspace.  It contains
the following items:

Cascade:  This command arranges the open document windows in the TShell workspace in an overlapped
fashion, with the title bar of each document visible.

Tile:  This command arranges the open document windows in the TShell workspace in a non-overlapped
fashion so that each document is completely visible, reducing the size of the windows as necessary.

Arrange Icons:   This command arranges the icons for minimized document windows at the bottom of the
TShell workspace.  If there is an open window at the bottom of the workspace, then some or all of the icons
may be hidden behind the open window.

2.3.7 Help Menu
The Help menu allows you to access the on-line help for TSIS, TShell, and any of the TSIS tools that provide
on-line help.  This menu also provides access to the TSIS web site and to the form used to report problems
with the TSIS package.  It contains the following items:
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Help Topics:  When you select the Help Topics item from the Help menu, a submenu will appear.  The
submenu contains a list of items (tools) that provide on-line help.  Selecting one of the tool listed in the
submenu displays the on-line help for that tool.

Tip of the Day…:  This command displays the Tip of the Day dialog that allows you to view useful tips
related to the TSIS package.  From this dialog, you can also select whether you want the tips dialog to be
displayed on TSIS startup.

TSIS Web Site…:  This command launches your default browser to access the TSIS web site.

Report Problem:  This command opens the TSIS problem report  form in the Text Editor.  From the editor,
you can fill out the form for submission to your TSIS vendor.  You may also customize the form with your
personal information and save the customized form for future use.

About TSIS…:  This command displays a dialog that provides information about the TSIS package, including
version information, copyright information, and user registration information.  The dialog also lists the current
system resources including available memory and disk space.

2.4 Toolbars
Toolbars are a set of buttons that, when pressed, invoke many commonly used commands normally issued
using the menu system.  TShell features three toolbars:  (1) a Main toolbar for application specific commands
such as opening a file or printing, (2) a Traffic Tool toolbar for executing TSIS traffic tools, and (3) a
Simulation Control toolbar, used to control the execution of simulation tools .

TShell toolbars are dockable, meaning that you can position them anywhere within the TShell application
window (referred to as floating the toolbar) or attach them to the frame of the TShell application window
(referred to as docking the toolbar).  To move a toolbar, click and hold in the area between any button and the
toolbar outline.  You can then drag the toolbar to any location, or dock it to any of the four sides of the TShell
window frame.  While a toolbar is floating, you may hide the toolbar by clicking the "X" button in the upper
right of the toolbar.  Each button on a toolbar has a tool tip associated with it.  The tool tip is a short
description of the button that appears after a short period of time when you place the arrow cursor over the
button.  A short description of the button is also displayed in the status bar whenever the arrow cursor is over
the button.

2.4.1 Main Toolbar
The TShell Main toolbar is shown, in its floating state, in the following figure.  This toolbar contains eleven
buttons that duplicate the action of several of items on the File, Edit, and Help menus.  The action of each of
these buttons is described below.
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  New Project File:  This button displays the Project Description dialog that allows you to create a new
project (TCF) file.

  Open Project:  This button displays a file open dialog that allows you to select a project (TCF) file to
open.

  New File:  This button displays the Choose Tool dialog that lists the configured editor tools .  Selecting
one of these tools opens the tool for creating a new file.

  Open Selected File:  This button displays the Choose Tool dialog that lists the configured tools that
are associated with the file that is currently selected in the TShell Project View.  You may then choose one of
the tools to open the file.  If there is only one tool associated with the file, the Choose Tool dialog is not
displayed and the file is opened with that tool.

  Save:  This button saves the active document to its associated file.

  Cut:  This button removes the selected text or object from the active document and puts the selection
into the Windows clipboard.

  Copy:  This button copies the selected text or object from the active document or TShell sub-view and
puts the selection into the Windows clipboard.

  Paste:  This button inserts the contents from the Windows clipboard into the active document at the
location of the caret.  If there is a current selection in the document, this command replaces the selection with
the contents of  clipboard.

  Print:  This button command displays a print dialog that allows you to print the contents of the active
document window or TShell sub-view that has focus.

  About:  This button displays a dialog that provides information about the TSIS package, including
copyright information and user registration information.  The dialog also lists the current system resources
including available memory and disk space.

  Help:  This button displays the on-line help for the TShell application.

2.4.2 Traffic Tool Toolbar
The Traffic Tool toolbar is shown, in its floating state, in the following figure.  This toolbar contains a button
for each of the configured TSIS tools.   The buttons in the figure represent the tools that come pre-configured
with the TSIS package.  Buttons will be enabled for those tools that are associated with the file type of the
active document or selected item in the Project View.  Clicking on a tool button with the left mouse button
activates the tool, while clicking on the tool button with the right mouse button displays the Configuration
dialog for the tool.  Clicking a tool button with the right mouse button works even when the tool button is
disabled.  The specific action of each of these buttons is described below.

  Script Tool:  This button executes the Script Tool on the file associated with the active document or the
currently selected item in the TShell Project View.
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  CORSIM:  This button executes CORSIM on the file associated with the active document or the
currently selected item in the TShell Project View.

  TRAFVU:  This button executes TRAFVU on the file associated with the active document or the
currently selected item in the TShell Project View.

  Text Editor:  This button executes the Text Editor on the file associated with the active document or the
currently selected item in the TShell Project View.

  Translator:  This button executes the Translator on the file associated with the active document or the
currently selected item in the TShell Project View.

  TRAFED:  This button executes TRAFED on the file associated with the active document or the
currently selected item in the TShell Project View.

2.4.3 Simulation Control Toolbar
The Simulation Control toolbar is shown, in its floating state, in the following figure.  This toolbar contains
four buttons that duplicate the actions of the Execution Controls submenu of the Tools menu.  These buttons
are active only when a simulation tool is running.  The action of each of these buttons is described below.

  Abort Simulation: This button terminates the execution of the currently running simulation tool.

  Pause  Simulation:  This button pauses the execution of the currently running simulation tool.

  Resume Simulation: This button resumes the execution of the currently paused simulation tool.

  Step Simulation: This button executes one time step for the currently paused simulation tool.

2.5 Status Bar
The status bar, illustrated in the following figure, forms the bottom edge of the main TShell window.  The
status bar consists of multiple display panes, each providing information about the active document.  The
figure illustrates the status bar for a document open in the Text Editor.

Although the contents of the status bar vary depending on the tool associated with the active document, it
contains several panes that are consistent between tools.  For all tools, the status bar displays a brief description
of the command performed by a button or menu item when the mouse cursor is over the button or item.  The
description appears in the left-most part of the status bar.  The contents of the next pane are dependent on the
tool associated with the active document.  In the example, the Text Editor displays the line and column number
for the current position of the caret in the document.  Please refer to the documentation for the each of the tools
for details on the items each tool displays in the status bar.
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The next three panes indicate the status of the Caps Lock, Num Lock, and Insert keys on the keyboard.  If a
pane is empty, it indicates the key is not active.  Pressing a key toggles the state of its associated indicator in
the status bar.  The Insert key toggles the state of the overstrike mode in a text editor.

The last two panes of the status bar indicate the current system date and time.  The visibility of these two panes
can be set via the Status Bar Settings tab in the Preferences Dialog.

Finally, you can show or hide the status bar by enabling or disabling the View|Status Bar  menu item.

2.6 Project View
The Project View is a dockable control window that displays a hierarchical tree structure of projects, cases, and
case files.  Using this tree structure, you can efficiently manage your traffic analysis projects.  You can also
execute tools on the files presented by this view.  The Project View is illustrated in the following figure.

Because the Project View is dockable, you can position it anywhere within the TShell application window
(referred to as floating the view) or attach it to the frame of the TShell application window (referred to as
docking the view).  To move the Project View, click and hold in its frame (the gray area).  You can then drag
the view to any location, or dock it to either the left or right sides of the TShell window frame.  The vertical bar
on the side of the Project View is used to size the width of the view while it is docked.  While the view is
floating, you may hide it by clicking the "X" button in the upper right of the view.  TShell stores the state, size,
location, and current contents of the Project view between sessions so that these items will be restored the next
time you use TShell.  The Project View contains the following buttons:

  Hide Project View:  This button hides the Project View.  You can restore the Project View using the
View|Project View menu item.

  Open Project:  This button displays a file open dialog that allows you to select a project (TCF) file to
open.  The opened project is added to the tree in the Project View.

  Close Project:  This button closes (removes from the view) the project associated with the currently
highlighted tree item.

2.6.1 Projects
The highest level item in the tree structure represents a TSIS project.  A TSIS project is a set of simulation
cases  that reflect a common theme, e.g., signal timing variations for an artery in downtown Washington, D.C.
In general, a project is composed of simulation cases.  A simulation case is a single simulation for a specified
traffic network as defined by its simulation input file, e.g., one of the signal timing variations.  A case includes
the simulation input file and all data files generated by the simulation during a run.  Note, multiple runs of the
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simulation for gathering statistics is still considered part of a single case if the input (other than random
number seeds) has not changed.  TShell stores all files that pertain to a project in a single directory.

Clicking on the "+" icon in front of a project item in the tree, expands the tree to show the cases  that compose
the project.  Clicking on the "-" icon in front of a project item in the tree, compresses the tree to hide the cases
that compose the project.  Double clicking the project item will also toggle the expanded state of the project.
Additionally, pressing the Enter key while a project item is highlighted toggles the expanded state of the
project.

Clicking the project item with the left mouse button highlights the project item in the tree.  While the project
item in the tree is highlighted, you can delete the project using the Delete key or the Edit|Delete  menu item.
When you delete a project, all of the cases and case files for the project will be deleted from the system's hard
drive.

Clicking the project item with the right mouse button displays the following pop-up menu.

Clean…:  This command "cleans" the project.  When a simulation tool fails to terminate cleanly, e.g., an
unexpected execution error occurs, residual files may be left in the project directory.  Removing these files
may be necessary prior to executing the simulation tool again.  Cleaning removes these residual files.

Delete…:  This command deletes the project, deleting all of its cases and case files from the system's hard
drive.

Close:  This command closes (removes from the view) the project.

2.6.2 Cases
The second level item in the tree structure represents a case.  A TSIS project is a set of simulation cases that
reflect a common theme, e.g., signal timing variations for an artery in downtown Washington, D.C.  In general,
a project is composed of simulation cases.  A simulation case is a single simulation for a specified traffic
network as defined by its simulation input file, e.g., one of the signal timing variations.  A case includes the
simulation input file and all data files generated by the simulation during a run.  Note, multiple runs of the
simulation for gathering statistics is still considered part of a single case if the input (other than random
number seeds) has not changed.  All files that pertain to a case have the same root file name, which is the name
of the case that appears in the tree structure.

Clicking on the "+" icon in front of a case item in the tree, expands the tree to show the files that compose the
case.  Clicking on the "-" icon in front of a case item in the tree, compresses the tree to hide the files that
compose the  case.  Double clicking the case item will also toggle the expanded state of the case.
Additionally, pressing the Enter key while a case item is highlighted toggles the expanded state of the case.

Clicking the case item with the left mouse button highlights the case item in the tree.  While the case item in
the tree is highlighted, you can delete the case using the Delete key or the Edit|Delete menu item.  When you
delete a case, all of the files for the case will be deleted from the system's hard drive.

Clicking the case item with the right mouse button displays the following pop-up menu.

Clean…:  This command "cleans" the case.  When a simulation tool fails to terminate cleanly, e.g., an
unexpected execution error occurs, residual files may be left in the case directory.  Removing these files may
be necessary prior to executing the simulation tool again.  Cleaning removes these residual files.

Delete…:  This command deletes the case, deleting all of its files from the system's hard drive.
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2.6.3 Files
Each simulation case consists of at least one file.  The number and types of files that compose a case depend on
the tools that are used to define, process, and analyze the case.

Clicking file item with the left mouse button highlights the file item in the tree.  While the file item in the tree
is highlighted, you can delete the file using the Delete key or the Edit|Delete menu item.  When you delete a
file, it will be deleted from the system's hard drive.

Double clicking the file item with the left mouse button executes the default tool associated with the file.  For
example, in the default tool configuration the default tool for a TRF input file is the Text Editor.  Double
clicking on the TRF file item in the tree opens that file in the Text Editor.

Clicking the file item with the right mouse button displays the following pop-up menu.

Open:  This command executes the default tool associated with the file.

Open with:  When you select the Open with item from the menu, a submenu will appear.  The submenu
contains a list of items (tools) that are associated with the file.  In this list, the default tool is in bold.  Selecting
an item in this submenu executes the selected tool on the file.

Clean…:  This command "cleans" the case associated with the file.  When a simulation tool fails to terminate
cleanly, e.g., an unexpected execution error occurs, residual files may be left in the case directory.  Removing
these files may be necessary prior to executing the simulation tool again.  Cleaning removes these residual
files.

Delete…:  This command deletes the file, removing it from the system's hard drive.

2.7 Output View
The Output View is a dockable control window that displays the output generated by the traffic tools as they
operate on files.  Because the Output View is dockable, you can position it anywhere within the TShell
application window (referred to as floating the view) or attach it to the frame of the TShell application window
(referred to as docking the view).  To move the Output View, click and hold in its frame (the gray area).  You
can then drag the view to any location, or dock it to bottom of the TShell window frame.  The horizontal bar on
the top of the Output View is used to size the height of the view while it is docked.  While the view is floating,
you may hide it by clicking the "X" button in the upper right of the view.  TShell stores the state, size, and
location of the Output View between sessions so that these items will be restored the next time you use TShell.

The Output View is a container for multiple tabs.  One of these tabs is reserved for the TSIS Welcome page,
while the other tabs are associated with the tools.

2.7.1 Welcome Tab
The following figure illustrates the TSIS Welcome  Tab.  The Welcome Tab contains a copy of the Microsoft
Internet Explorer browser.  The default page for the browser contains links that allow you to view different
files and sites that provide information about the TSIS package.
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While the Welcome Tab is active, the frame of the Output View contains the following buttons:

  Hide Output View:  This button hides the Output View.  You can restore the Output View using the
View|Output View menu item.

  Close Tab:  This button closes the Welcome Tab.  You can restore the Welcome Tab using the
View|Welcome Page menu item.

  Stop Navigation:  This button stops the browser from navigating to the specified site or loading the
current document.

  Home:  This button causes the browser to navigate to your system-specified home site (page).

  Navigate Forward:  This button causes the browser to navigate to the next site.  It becomes active when
you have loaded more than one site.

  Navigate Backward:  This button causes the browser to navigate to the previous site.  It becomes active
when you have loaded more than one site.

2.7.2 Tool Tab
The following figure illustrates the style of tab that is associated with most tools in the TSIS suite.
Specifically, this figure shows the tab that is associated with the Text Editor.  The output information that is
contained in the tool tab is dependent on the tool associated with the tab.  For details regarding this
information, please refer to the user's guide for the specific tool of interest.

While a tool tab is active, the frame of the Output View contains the following buttons:

  Hide Output View:  This button hides the Output View.  You can restore the Output View using the
View|Output View menu item.

  Close Tab:  This button closes the tab.
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2.7.3 Simulation Tool Tab
The following figure illustrates the style of tab that is associated with simulation tools  in the TSIS suite.
Specifically, this figure shows the tab that is associated with CORSIM.  The output information that is
contained in this tab is dependent on the simulation tool associated with the tab.  For details regarding this
information, please refer to the user's guide for the specific tool of interest.

While a simulation tool tab is active, the frame of the Output View contains the following buttons:

  Hide Output View:  This button hides the Output View.  You can restore the Output View using the
View|Output View menu item.

  Close Tab:  This button closes the tab.

  Abort Simulation: This button terminates the execution of the currently running simulation tool.

  Pause  Simulation:  This button pauses the execution of the currently running simulation tool.

  Resume Simulation: This button resumes the execution of the currently paused simulation tool.

  Step Simulation: This button executes one time step for the currently paused simulation tool.

2.8 Workspace
The TShell workspace is that portion of the TShell frame not in use by the Project and Output views and the
TShell menu and toolbars.  In this area TShell displays the document windows that are associated with the
tools in use.  The workspace operates in accordance with the Multiple Document Interface (MDI) standard
supported by Microsoft.  Within this interface, you can easily navigate between the windows and can also
change the relative layout of the windows using the cascade and tile commands from the Window menu.

The Window menu contains a list of all open documents.  From this list, you can choose which document
window you want to activate, i.e., bring to the top of the display.  You can also switch between documents
using the Ctrl+Tab keyboard command.  When you maximize a document window (by clicking on the
maximize button or double clicking on its title bar), that window fills the workspace, covering all other
document windows.

For increased viewing area, you can press the F2 key to shift into full screen mode.  In full screen mode, the
active document window fills the entire screen (except for the space reserved for the TShell menu bar).
Pressing the F2 key again restores the TShell workspace to normal mode.
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2.9 Help System
In this section, we cover the aspects of the TShell help system in more detail.  The components of the help
system are available via the TShell Help menu.

2.9.1 Help Topics
Help topics for TSIS, TShell, and its tools can be accessed via the Help|Help Topics  menu item.  Selecting
this item produces a submenu list of all help files available with the TSIS package.  The first item on this list is
the TSIS User's Guide.  That guide provides information regarding the entire TSIS package including
installation instructions and vendor information.  The second item on the submenu list is the TShell User's
Guide (this document).  Both of these guides are provided on-line using the Microsoft HTML Help Viewer.
The remainder of the items on the submenu list are the user's guides associated with the tools that are currently
installed in TSIS.  Note, not all tools may provide a help item.

2.9.2 Tip of the Day
In the delivered configuration, the Tip of the Day dialog appears every time you start TShell.  Each time it
displays a different helpful note about the TSIS package.  You may also access this dialog via the Help|Tip of
the Day menu item.  The Tip of the Day dialog is illustrated in the following figure.

From this dialog you can enable / disable the automatic display of the Tip on startup using the “Show Tips at
Startup” checkbox.   This dialog also provides a Next Tip button that allows you to scan through the TSIS tips.

2.9.3 TSIS Web Site
The Help|TSIS Web Site  menu item invokes your configured web browser with the TSIS home page.  The
TSIS home page is illustrated in the following figure.  The TSIS web site provides the latest information
regarding the TSIS package and provides a forum for users to exchange information regarding the practical
application of TSIS.
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2.9.4 Report Problem
The Help|Report Problem menu item opens the problem report text file in the Text Editor.  This file contains
a problem report form that you may submit to your vendor to notify FHWA about problems with the TSIS
package or to suggest enhancements to the package.  The form is shown in the following figure.

The problem report text file is named problem.txt and resides in the folder to which TSIS was installed.  This
file is installed as a read-only file.  However, you can make changes to the form and save it to a different file
name for submission to your vendor.  Alternatively, you can make the file writable and then customize it with
your own user information.  Once done, you can then make the file read-only to be used as your own personal
template for submitting problem reports and suggestions.  This eliminates the need to enter your user or
computer information every time you create a problem report.
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2.9.5 About TSIS
The Help|About TSIS  menu item displays information about the TSIS package.  The information includes a
copyright notice, credits, version number, and registration information for your copy of TSIS.  This dialog also
provides information about system resources, including available memory and disk space.
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3 TShell Preferences

3.1 Preferences Overview
You can customize the many of the elements of the TShell application.  To access the Preferences
configuration dialog, select the Options|Preferences  menu command.  The TShell application "remembers"
your preferences as well as the size and position of its toolbars and the Project and Output views between
sessions.  It also keeps a list of the projects that you have open in the Project View between sessions. Window
sizing, project, and preference information is stored in the system registry by user.  This means that if three
different users (as identified by the operating system) log in to the same computer to use TSIS, TShell keeps
the information for each user, restoring the layout and preferences for the user that logs in to use TSIS.

The Preference dialog contains several tabs, each of which is described in the following sections.

3.2 Output Settings Tab
The Output Settings tab, shown below, contains settings used to control the look of the text displayed in the
Output View.  From this tab you can set the color for the message types displayed in the Output View as well
as the font and font size for the text.
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Text Color
The text displayed in the Output View can be color-coded for quick reference.  To change the color of any of
these message types, press the desired button to bring up Color dialog.  Select the desired color and push the
OK button to return to the Output Settings tab.

The text colors can be set for the following message types:

• TSIS Messages  – Messages generated directly by TShell.

• Error Messages  – Error Messages generated by TShell or an embedded DLL.

• Main Library Messages  – Messages generated by any TSIS DLL Tool type (such as CORSIM ).

• CORSIM Run-Time Extension Messages  – Messages generated by a CORSIM run-time extension.

• TSIS/DLL Interface Messages  – Special messages generated by TShell or an embedded DLL.

• Other Messages  – Specially colored messages that can be sent by an embedded DLL (DLL –
Specific).

Font Type and Size
You can select from the Font drop-down list the type of font used for text in the Output View.  This list
contains all fonts installed on your system.  You may also select the size of the font from the Font Size drop-
down list.
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3.3 Default Project Directory Tab
When TSIS was installed on your system, the setup program asked the installer to specify a folder for the
sample projects delivered with TSIS.  That folder is the default directory for your projects.    That is, when you
want to open or create a project, TShell looks in this folder by default.  You can change the folder that is your
default project directory using the Default Project Directory tab, shown in the following figure.  You can
directly type in the directory path, or you may use the Browse button to search for the folder you want to
become your default project directory.

3.4 Web Browser Tab
The Web Browser Tab allows you to specify settings for the Help|TSIS Web Site  menu command.
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Web Browser:  This setting specifies the browser to use for the Help|TSIS Web Site  menu item.  That is,
the browser that will be launched to display the TSIS web site.  The default setting for this is the Microsoft
Internet Explorer.

TSIS Web Site:  This entry specifies the URL that is opened when the browser is launched via the
Help|TSIS Web Site  menu item.  The TSIS home page is http://www.fhwa-tsis.com.

Display Welcome Page at Startup:  The TSIS Welcome Page displays general information about TSIS.
This page is shown as one of the tabs in the TShell Output View.  You can control whether TShell displays this
tab at startup using the "Display Welcome Page at Startup" checkbox.

3.5 Status Bar Settings Tab
You can control whether to display the current system date and time in the TShell status bar from Status Bar
Settings tab, shown in the following figure.

Show Time:  Checking the Show Time checkbox displays the current system time in the TShell status bar.

Show Date:  Checking the Show Date checkbox displays the current system date in the TShell status bar.
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4 Creating Projects and Cases

4.1 Projects and Cases Overview
This chapter describes how to create new TSIS projects and cases .  It also describes how to create a project
when you already have CORSIM simulation input (TRF) files.

A TSIS project is a set of simulation cases  that reflect a common theme, e.g., signal timing variations for an
artery in downtown Washington, D.C.  A simulation case is a single simulation for a specified traffic network
as defined by its simulation input file, e.g., one of the signal timing variations.  A case includes the simulation
input file and all data files generated by the simulation during a run.  Note, multiple runs of the simulation for
gathering statistics is still considered part of a single case if the input (other than random number seeds) has not
changed.  TShell stores all files that pertain to a project in a single directory.

In essence, a project is a container for organizing and storing collections of related cases that pertain to a
particular traffic engineering study.  TSIS Projects help manage the various input and output case files that are
used by the TSIS tools.  A case is simply a collection of the tool input and output files that you associate with a
particular scenario of the study.  All files that belong to a case have the same root file name.  A file can contain
the input to or output from a tool.



Creating Projects and Cases

4-2 TShell User’s Guide

4.2 Creating a Project
You can create a new project by selecting the File|New menu command and selecting TSIS Project on the

displayed submenu or by pressing the New Project button    on TShell's Main toolbar.  This action
displays the Configure Project dialog, illustrated in the following figure.

When you create a project using the Configure Project dialog, the information is stored in a TCF file.  You can
specify both the name of the TCF file and the directory where it resides.  All case files that belong to the
project will reside in the directory where the TCF file is located.  We recommend that you place projects in
their own directory for easier management.

Project Name:  Use this field to specify the name for the project.  This is the name that is displayed in the
Project View tree and is the name given to the TCF file that defines the project.

Description:  Use this field to describe the project.  The description is stored as a text string in the project's
TCF file.

Created By:  Use this field to provide information about the person or organization that created the project.
This information is stored as a text string in the project's TCF file.

Project Directory:  Use this field to specify the location of the project's TCF file.  You can type in the
directory information or you can use the Browse button to the right of the field to find an existing folder on
your system or network.  The default for this field is your current default project directory preference setting.

Automatic:  When this item is checked, the Project Directory field is set to your current default project
directory preference, and the field is disabled.  When you type in the Project Name, it is appended to the
directory setting in the Project Directory field.  Thus, the new project's TCF file will reside in a sub-directory
of your default project directory.  The name of the sub-directory will be the name of the project file.

Creating a Project for an Existing TRF File
If you already have existing CORSIM input (TRF) files, but do not have a project for those files, it is easy to
create a project for those files.  Note, if you do not create a project, you will not be able to view the TRF files
in TShell's Project View.

To create a project for existing CORSIM input (TRF) files, open the Configure Project dialog as described
above.  Then remove the check mark from the Automatic check box.  Use the Browse button to locate the
directory where your TRF files reside.  Press the OK button on the Open dialog to set the directory you have
selected.  You can then type in the name of the project and any other information you desire.  Finally, close the
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Configure Project dialog with the OK button to save your project definition.  The newly created project will
appear in the TShell Project View, and all of the TRF files in the project directory will appear as cases  under
the project item.

4.3 Creating a Case
A case is defined by the input and output files with which the case is associated.  The files that define a case
have the same root name where the file extensions differentiate the types of files.  For example, a case may
consist of the following four files:  sample.trf, sample.tno, sample.out, and sample.tsd.  These files may have
been generated in the following sequence.  First, the user defines a network using the TRAFED  network editor.
On saving the network, TRAFED creates a sample.tno file.  The user then applies the TRAFED export feature
to create the sample.trf file for input into the CORSIM  simulation.  When CORSIM is run, it creates the
sample.out and sample.tsd files.  All four of the files are part of the "sample" case.

Note, not all case files will appear in the project tree.  Only those files with extensions that are associated TSIS
tools will appear in the tree.  Thus, even though the animation data file, sample.tsd, is part of the sample case,
it will not appear in the project tree.

To create a new case using the TSIS tools, you can either create a TRF file using the Text Editor, or create a
TNO file using TRAFED.  The case will appear under the project whose directory you saved the TRF or TNO
file.

To create a case using an existing TRF or TNO file, simply copy the file into an existing project directory.  The
case will then appear under the project item associated with that directory, and will have the same name as the
root name of the file.
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5 Tool Configuration

5.1 Tool Configuration Overview
TSIS is an integrated development environment that enables users to conduct traffic operations analysis.
Although TSIS has been available since the early 1990s, it was not until 1995 that it became a Windows-based
product.   With the introduction of TSIS 5.0, the environment has become more integrated and supports an
open component architecture that allows you to add and configure your own (or third-party) tools.

The TShell graphical user interface (GUI) provides you with the ability to effectively manage the tools in your
TSIS environment.  Although TSIS is distributed with a set of pre-configured tools, TShell allows you to easily
add and configure your own tools.

5.2 Tool Configuration Dialog
You can add, edit, or delete tools via the TShell Tool Configuration dialog.  To display this dialog, select the
Tools|Tool Configuration menu command.  The Tool Configuration dialog is illustrated in the following
figure.

The Tool Configuration dialog has three buttons and two tabs as follows:

OK:  This button closes the dialog, saving any changes you made to the tool configuration.

Cancel:  This button closes the dialog, rejecting all changes you made to the tool configuration.
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Help:  This button displays the help topic for the Tool Configuration Dialog.

Tool Set Configuration:  This tab is used to add, edit, or delete tools.

Default Tools:  This tab is used to assign a default tool to files with a  specific file extension.

The Tool Set Configuration tab contains a list of currently configured tools and three buttons:  Add, Edit, and
Delete.

Configured Tools:  This control lists the currently configured tools.  You can select tools from this list to
edit or delete.

Add:  This button starts the tool configuration wizard for adding and configuring a new tool.

Edit:  This button displays the Edit Existing Tool Configuration dialog for the tool that is highlighted in the
Configured Tools list.

Delete:  This button deletes the tool that is highlighted in the Configured Tools list.

5.2.1 Adding a Tool
To illustrate the process of adding a tool, we add the Microsoft Paint application.  Starting with the Tool
Configuration dialog, press the Add button.  This will start the tool configuration wizard, shown in the
following figure.

The first page of the tool configuration wizard is the same for all types of  tools.   Subsequent pages will differ
depending on the tool's file type and the selected category for the tool.  The first page of the wizard contains
the following controls.

Path:  This is the full path specification for the tool that you wish to add.  Use the button to the right of the
path specification field to browse the hard drive or network to select the file that defines the tool.  TShell
recognizes four types of files as tools:  applications (EXE files), dynamic link libraries (DLL files), ActiveX
controls (OCX files) , and batch programs (BAT files).

Name:  This field is used to set the name of the tool.  It defaults to the name portion of the tool's path
specification.  You can provide whatever name you wish, as long as it is unique within the set of existing tools.
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Category:   This radio button set is used to identify the type of tool being added.  In general, it does not matter
which category you choose; it defines which submenu of the Tools menu the tool is listed.  However, if the
tool can be used to create a file, the Editor category should be selected.  This causes the tool to be listed in the
submenu of the File|New menu item.  For Paint, we have selected "Editor" because it can be used to create
files.

Tool Tip String:  This field is used to set the tool tip that is displayed when the mouse is over the tool button.
It defaults to the tool name, but you can specify any string that you want.

Associated Extensions:   This field is used to set the file extensions that are associated with this tool.  The
first extension specified is the default extension.  You may enter multiple extensions, separated by semicolons.
This information is used to enable and disable the tool button based on the type of file selected in the project
tree.  If you specify no extension, the tool button will always be enabled.  For our example, we have selected
"bmp" for Windows bitmap files.

Toolbar Button Bitmap Path:  This field is used to specify the full path specification for a bitmap file that
will be used as the face for the tool button on the Tools toolbar.  You may select any bitmap file, however, we
have provided a set of properly sized (16 x 15) bitmap files for your convenience.  The button to the right of
the field will allow you to browse the hard drive or network to select a bitmap file.

After specifying all of the information on the first page of the wizard, press the Next button to continue the
new tool configuration process.  Because the Paint tool is an EXE file, the next page of the wizard will appear
as follows.

Optional Command Line Arguments:  This field allows you to specify command line arguments for the
application tool you are adding.  The specific arguments that can be specified depend on the tool you are
adding.  These arguments are passed to the tool executable when it is launched by TShell.  TShell also provides
a special token (%f) that you may specify to pass the name of the selected input file to the tool.  In the case of
Paint, simply passing a file name causes Paint to open that file when it starts.

Help File:  This control allows you to specify the type and location of a help file to be associated with the
tool.  If specified, the added tool will appear in the Help|Help Topics  submenu to provide access to the tool's
help file from TShell.  TShell supports two types of help, WinHelp, and HTML Help.  For our example, we
have not loaded a separate help file for the Paint tool.
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After specifying all of the information on the second page of the wizard, press the Finish button to finalize the
new tool configuration.  This will return you to the Tool Configuration dialog.  Note, the new tool will appear
in the list of tools, but won't be added until you press the OK button.

5.2.2 Editing an Existing Tool
From the Tool Configuration dialog, you can edit the configuration for an existing tool by highlighting the
desired tool and then pressing the Edit button.  You can also edit a tool's configuration by clicking the right
mouse button while the mouse cursor is over the tool's button in the Tools toolbar.

To illustrate this process, we describe editing the Microsoft Paint tool that was described in the section, Adding
a Tool.   Starting with the Tool Configuration dialog, highlight the PBRUSH tool and press the Edit button.
This will display the following configuration dialog for the PBRUSH tool.

This dialog has multiple tabs that contain the tool's configuration parameters.  The first tab of the configuration
dialog is the same for all types of  tools.   Additional tabs will differ depending on the tool's file type and the
selected category for the tool.  In edit mode, you are allowed to change all configuration parameters except for
the tool's path specification, thus the Path field is disabled (grayed).  When you are finished modifying the
configuration, press the OK button to save your changes and return to the Tool Configuration dialog.  Pressing
Cancel will reject your changes.  Note, your changes will also be rejected if you do not press the OK button on
the Tool Configuration dialog.

5.2.3 Deleting an Existing Tool
From the Tool Configuration dialog, you can easily delete a tool by highlighting the desired tool and then
pressing the Delete button.  The tool's name will disappear from the Configured Tools list.  However, the tool
will not actually be deleted until you press the OK button on the Tool Configuration dialog.

5.2.4 Specifying Default Tools
The Default Tools tab in the Tool Configuration dialog allows you to specify the primary (or default) tool
associated with a file extension.  The default tool is the tool that is activated when you double click (or press
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the Enter key) on a file item in the Project View tree.  The Default Tools tab is illustrated in the following
figure:

In this tab, the file type (extension) list contains a single entry for every extension that was specified in the tool
configurations (i.e., every extension known to TShell).  Although an extension can be associated with multiple
tools, only one tool is considered the default tool.

As illustrated in the figure, TRF (CORSIM input) files can be operated on by four tools: CORSIM, TRAFVU,
TextEditor, and Translator.  The toolbar buttons associated with these tools will be enabled whenever a TRF
file is highlighted in the Project View tree.  However, the Text Editor tool is defined as the default
(highlighted) tool.  This means that when a user double clicks on a TRF file in the project tree, that TRF file
will be opened by the TextEditor.  Using this dialog, you can change the default tool to be any of the tools that
support the selected file type.

This dialog also enables you to select the name that appears in the Project View tree for files of the selected
type.  The figure indicates that TRF files are listed as "Simulation (*.trf)" files in the project tree.  You can
change the name to be whatever is most meaningful to you.
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6 Glossary of Terms

accelerator key
Accelerator keys (also known as shortcut keys) are used as keyboard shortcuts for program commands that are
also available on a menu or toolbar.

ATMS
Advanced Traffic Management Systems

case
A single simulation for a specified traffic network as defined by its simulation input file.  A case includes the
simulation input file and all data files generated by the simulation during a run.  Note, multiple runs of the
simulation for gathering statistics is still considered part of a single case if the input has not changed.

CORSIM
CORridor SIMulation.  This is a microscopic traffic simulation used to generate the vehicle information used
by TRAFVU.

DOT
Department of Transportation

dynamic scrolling
With dynamic scrolling, the contents of a window scrolls as the user moves a scroll bar thumb.

FHWA
Federal Highway Administration.  Sponsor for the development of the TSIS suite of traffic analysis tools.

graphical user interface
A interface between a user and a software tool, consisting of graphical elements and controls, e.g., windows,
dialogs, buttons.
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GUI
Graphical User Interface

HTML
Hypertext Markup Language is a system of marking up or tagging a document so that it can be published on
the World Wide Web.  It is used to display TShell on-line help.

MDI
Multiple Document Interface

Script Tool
The TSIS Script Tool is a combined script editor and tool for executing Visual Basic Scripts.  Using the built-
in TSIS interfaces, the Script Tool is a powerful mechanism for extending the functionality of the other TSIS
components.

TCF
TSIS Configuration File.  A file that defines a TSIS project and contains information about the project , e.g.,
project description and creator.

Text Editor
This editor is a standard text editor that has the additional capability of "understanding" the CORSIM TRF file
format.  When editing a TRF file with this editor, the TShell output window displays text describing the entry
field and record type at the current cursor position.  Clicking a specific field description in the output window
highlights the corresponding entry field in the displayed TRF file.

thumb
A thumb is the rectangular button in a scroll bar that can be moved to scroll the contents of the window to
which the scroll bar is attached.

time step
The smallest unit of time at which the simulation model (CORSIM ) reports information.  The time step is
typically one second.  CORSIM reports vehicle positions, signal states, and controller information at each time
step.

TNO
Traffic Network Object.  A file format used by the TRAFED network editor.

tool
A program or component that is installed into the TSIS environment for use in conducting traffic operations
analysis.  A tool can be an application (EXE), Dynamic Link Library (DLL), COM object or ActiveX Control
(OCX), or a batch program (BAT).
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tool tip
A small rectangular pop-up window that displays a brief description of a command bar (toolbar) button's
purpose.

TRAFED
TRAF Editor.  A graphical input editor used to define traffic networks and other input for simulation.  It is part
of the TSIS suite of tools.

TRAFVU
TRAF Visualization Utility.  A graphics processor used to display traffic networks and animate vehicles and
signals on that network.  It is part of the TSIS suite of tools.

Translator
A TSIS tool used to translate between the TRF and TNO file formats.  It converts TRF files for use by
TRAFED.  The translator also performs the reverse operation of translating the TRAFED native format (TNO)
files into TRF files for use by CORSIM  and other tools.

TRF
A file that contains the input data used to define a CORSIM network and to drive the CORSIM simulation for
a single simulation case.

TSD
Time step data file.  A file that contains the time step-dependent vehicle and signal state information generated
by the simulation and used as input to TRAFVU.

TShell
The graphical user interface for the TSIS integrated development environment.  It provides a Project view that
enables you to manage your TSIS projects.  It is also the container for the pre-configured tools and any tools
that you add to the suite.

TSIS
Traffic Software Integrated System.  TSIS is the integrated development environment that hosts the CORSIM
simulation and its support tools.

TSIS Web Site
This web site, http://www.fhwa-tsis.com, contains the latest information about new tools, product updates,
known problems, example projects, and usage tips.

Visual Basic Script
VBScript is a lightweight and extremely fast language engine designed specifically for environments like the
Internet, intranets, or the World Wide Web.
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7 Index

A

abort 2-5, 2-6, 2-10, 2-15

C

cascade 2-7, 2-15
cases 1-1, 2-4, 2-11, 2-12, 2-13, 4-1, 4-2, 4-3, 5-3, 6-1, 6-3
cleaning 2-12, 2-13
colors 3-1, 3-2
CORSIM 2-10, 2-15, 3-2, 4-1, 4-2, 4-3, 5-5, 6-1, 6-2, 6-3

D

date 2-11, 3-4
default project directory 3-3, 4-2
Default Project Directory 3-3
default tool 2-13, 5-2, 5-4, 5-5

E

edit commands
copy 2-4, 2-9
cut 2-4, 2-9
delete 2-4, 2-12, 2-13, 5-2, 5-4
find 2-2, 2-4
paste 2-4, 2-9
redo 2-4
select all 2-4
undo 2-4

Edit menu 2-3
editor tools 2-6, 2-9
extensions 4-3, 5-2, 5-3, 5-4

default 5-3
multiple 5-3

F

Federal Highway Administration i, iii, v, 2-17, 6-1
File menu 2-3
fonts 3-1, 3-2
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full screen mode 2-5, 2-15

H

help 1-1, 2-2, 2-3, 2-5, 2-7, 2-8, 2-9, 2-16, 2-17, 2-18, 3-3, 3-4, 4-1, 5-2, 5-3, 6-2
Help menu 2-5, 2-7, 2-8, 2-16

I

ITT Industries, Inc., Systems Division i, ii, iii

M

Main toolbar 2-5, 2-8, 4-2
menu bar 2-1, 2-2, 2-15
menus

Edit 2-3
File 2-3
Help 2-5, 2-7, 2-8, 2-16
Options 2-5
Tools 2-5, 2-6, 2-10, 5-3
View 2-4, 2-11, 2-14, 2-15
Window 2-7, 2-15

Microsoft Windows 1-1, 2-2

O

Options menu 2-5
Output Settings 3-1, 3-2
Output View 2-2, 2-5, 2-13, 2-14, 2-15, 3-1, 3-2, 3-4

P

pause 2-5, 2-6, 2-10, 2-15
preferences 1-1, 2-5, 2-11, 3-1, 4-2

Default Project Directory 3-3
Output Settings 3-1, 3-2
Status Bar Settings 2-11, 3-4
Web Browser 3-3, 3-4

printing 2-2, 2-3, 2-8, 2-9
problem report 2-8, 2-17
processor tools 2-6
Project Description 2-5, 2-9
project tree 2-2, 2-11, 2-12, 2-13, 4-2, 4-3, 5-3, 5-5
Project View v, 2-2, 2-3, 2-4, 2-5, 2-6, 2-7, 2-9, 2-10, 2-11, 3-1, 4-2, 4-3, 5-5
projects v, 1-1, 2-2, 2-3, 2-4, 2-5, 2-6, 2-7, 2-9, 2-10, 2-11, 2-12, 2-15, 3-1, 3-3, 4-1, 4-2, 4-3, 5-3, 5-5, 6-2, 6-3

R

reporting problems 2-8, 2-17
resume 2-5, 2-6, 2-10, 2-15

S

saving files 2-3, 2-9
Script Tool 2-7, 2-9, 6-2
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simulation control
abort 2-5, 2-6, 2-10, 2-15
pause 2-5, 2-6, 2-10, 2-15
resume 2-5, 2-6, 2-10, 2-15
step 2-5, 2-6, 2-10, 2-15, 6-2, 6-3

Simulation Control toolbar 2-5, 2-8, 2-10
simulation tools 2-5, 2-6, 2-8, 2-15
status bar 2-1, 2-5, 2-8, 2-10, 2-11, 3-4
Status Bar Settings 2-11, 3-4
step 2-5, 2-6, 2-10, 2-15, 6-2, 6-3

T

Text Editor 2-8, 2-10, 2-13, 2-14, 2-17, 4-3, 5-5, 6-2
tile 2-7, 2-15
time 2-11, 3-4
time step 2-6, 2-10, 2-15, 6-2, 6-3
Tip of the Day 2-8, 2-16
title bar 2-1, 2-2, 2-7, 2-15
TNO file 4-3, 6-2, 6-3
tool categories 2-3, 2-5, 2-6, 5-2, 5-3, 5-4

editors 2-6, 2-9
processors 2-6
simulators 2-5, 2-6, 2-8, 2-15
viewers 2-7

tool configuration 1-1, 2-7, 2-13, 5-1, 5-2, 5-3, 5-4, 5-5
tool tips 2-8, 5-3, 6-3
toolbars 2-1, 2-4, 2-5, 2-8, 2-9, 2-10, 2-15, 3-1, 5-3, 5-4, 5-5, 6-1, 6-3

Main 2-5, 2-8, 4-2
Simulation Control 2-5, 2-8, 2-10
Traffic Tool 2-5, 2-8, 2-9

Tools menu 2-5, 2-6, 2-10, 5-3
TRAFED ii, 2-2, 2-10, 4-3, 6-2, 6-3
Traffic Tool toolbar 2-5, 2-8, 2-9
TRAFVU ii, 2-10, 5-5, 6-1, 6-2, 6-3
Translator 2-10, 5-5, 6-3
tree 2-2, 2-11, 2-12, 2-13, 4-2, 4-3, 5-3, 5-5
TRF file 2-13, 4-1, 4-2, 4-3, 5-5, 6-2, 6-3
TShell layout 1-1, 2-7, 2-15, 3-1
TShell Layout 2-1
TSIS web site 2-7, 2-8, 2-16, 3-4

V

View menu 2-4, 2-11, 2-14, 2-15
viewer tools 2-7
Visual Basic scripts 2-5, 2-7, 6-2, 6-3

W

Web Browser 3-3, 3-4
Welcome tab 2-2, 2-5, 2-13, 2-14, 3-4
Window menu 2-7, 2-15
workspace 2-2, 2-7, 2-15


